Serial Converter Module

22-SCM-232
FRN 2.xxx

User Manual
Important User Information

Solid state equipment has operational characteristics differing from those of electromechanical equipment. “Safety Guidelines for the Application, Installation and Maintenance of Solid State Controls” (Publication SGI-1.1 available from your local Rockwell Automation Sales Office or online at http://www.ab.com/manuals/gi) describes some important differences between solid state equipment and hard-wired electromechanical devices. Because of this difference, and also because of the wide variety of uses for solid state equipment, all persons responsible for applying this equipment must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc. is prohibited.

Throughout this manual we use notes to make you aware of safety considerations.

---

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss.

**Attention** helps you:
- identify a hazard
- avoid the hazard
- recognize the consequences

**Important:** Identifies information that is especially important for successful application and understanding of the product.

**Shock Hazard** labels may be located on or inside the drive to alert people that dangerous voltage may be present.

---

Allen-Bradley, ControlFLASH, DPI, DSI, DriveExplorer, DriveExecutive, MicroLogix, SLC, PLC-5, ControlLogix, and CompactLogix are trademarks of Rockwell Automation, Inc.

PowerFlex® is a registered trademark of Rockwell Automation, Inc.

RSLogix is a trademark of Rockwell Software.

Windows, Windows CE, Windows NT, Windows ME, Windows 2000, Windows XP, and Microsoft are either registered trademarks or trademarks of Microsoft Corporation.
This is the second release of the 22-SCM-232 serial converter module (FRN 2.xxx).

<table>
<thead>
<tr>
<th>Location</th>
<th>Description of Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4</td>
<td>Added (before old Chapter 4 - Troubleshooting) to describe how to use 22-SCM-232 module with Allen-Bradley controllers to control and read/write data to PowerFlex® 4 and 40 drives.</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Was Chapter 4 - renumbered to 5.</td>
</tr>
<tr>
<td>Appendix D</td>
<td>Added to describe MicroLogix 1000 example ladder program.</td>
</tr>
<tr>
<td>Appendix E</td>
<td>Added to describe MicroLogix 1200/1500 example ladder program.</td>
</tr>
<tr>
<td>Appendix F</td>
<td>Added to describe SLC example ladder program.</td>
</tr>
<tr>
<td>Appendix G</td>
<td>Added to describe PLC example ladder program.</td>
</tr>
<tr>
<td>Appendix H</td>
<td>Added to describe ControlLogix example ladder program.</td>
</tr>
<tr>
<td>Appendix I</td>
<td>Added to describe the Logic Command/Logic Status words that are used for PowerFlex 4 and 40 drives.</td>
</tr>
</tbody>
</table>
Notes:
# Table of Contents

**Preface**
- About This Manual
  - Related Documentation ........................................... P-1
  - Conventions Used in this Manual .............................. P-1
  - Rockwell Automation Support ................................. P-2

**Chapter 1**
- Getting Started
  - Components ....................................................... 1-1
  - Features .......................................................... 1-2
  - Compatible Products .......................................... 1-2
  - Required Equipment ............................................ 1-3
  - Safety Precautions ............................................. 1-4
  - Quick Start ..................................................... 1-5
  - Modes of Operation ............................................. 1-6

**Chapter 2**
- Installing the Serial Converter Module
  - Selecting Cables .................................................. 2-1
  - Installing the Serial Converter Module ....................... 2-2
  - Removing the Serial Converter Module ....................... 2-3

**Chapter 3**
- Configuring the Serial Converter Module
  - Configuration Tools ............................................. 3-1
  - Using DriveExplorer ............................................ 3-2
  - Using Terminal Emulation Software ............................ 3-3
  - Setting the RS-232 Serial Port Rate ......................... 3-7
  - Setting the Fault Action ...................................... 3-8
  - Resetting the Serial Converter Module ...................... 3-9

**Chapter 4**
- Controlling PowerFlex 4 and 40 Drives with Allen-Bradley Controllers
  - Controller Compatibility ...................................... 4-1
  - Cabling Requirements .......................................... 4-2
  - Messaging (MSG Instruction) .................................. 4-3
  - PowerFlex 4 and 40 Memory Addressing ....................... 4-4
  - Example Controller Programs ................................ 4-4

**Chapter 5**
- Troubleshooting
  - Understanding the Status Indicators ....................... 5-1
  - Module Diagnostic Items ..................................... 5-3
  - Viewing and Clearing the Event Queue ..................... 5-3
  - Viewing and Clearing DF1 Communication Statistics ........ 5-5
  - Troubleshooting Potential Problems ........................ 5-6
# Table of Contents

## Appendix A Specifications
- Communications .................................................. A-1
- Electrical .......................................................... A-1
- Mechanical ......................................................... A-1
- Environmental ..................................................... A-2
- Agency Certification ............................................. A-2

## Appendix B Serial Converter Module Parameters
- Parameter List ..................................................... B-1

## Appendix C Flash Updates
- Preparing for a Flash Update .................................. C-1
- Performing a Flash Update with HyperTerminal .......... C-2
- Troubleshooting Potential HyperTerminal Flash Problems . C-3
- Performing a Flash Update with DriveExplorer ........... C-4

## Appendix D MicroLogix 1000 Example Ladder Program

## Appendix E MicroLogix 1200/1500 Example Ladder Program

## Appendix F SLC Example Ladder Program

## Appendix G PLC-5 Example Ladder Program

## Appendix H ControlLogix/CompactLogix Example Ladder Program

## Appendix I Logic Command/Status Words
- PowerFlex 4 and PowerFlex 40 Drives ....................... I-1

## Glossary

## Index
Preface

About This Manual

Read this preface to become familiar with the rest of the manual.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Documentation</td>
<td>P-1</td>
</tr>
<tr>
<td>Conventions Used in this Manual</td>
<td>P-1</td>
</tr>
<tr>
<td>Rockwell Automation Support</td>
<td>P-2</td>
</tr>
</tbody>
</table>

Related Documentation

<table>
<thead>
<tr>
<th>For Information On:</th>
<th>Refer to:</th>
<th>Publication</th>
</tr>
</thead>
<tbody>
<tr>
<td>DF1 Protocol</td>
<td><em>DF1 Protocol and Command Set Reference manual</em></td>
<td>1770-6.5.16</td>
</tr>
<tr>
<td>DriveExplorer™</td>
<td><em>DriveExplorer Getting Results Manual</em></td>
<td>9306-GR001…</td>
</tr>
</tbody>
</table>

Documentation can be obtained online at http://www.ab.com/manuals

Conventions Used in this Manual

The following conventions are used throughout this manual:

- Parameter names follow the format Parameter xx - [*]. The xx represents the parameter number. The * represents the parameter name. For example, Parameter 01 - [Adapter Cfg].

- Menu commands are shown in bold type face and follow the format Menu > Command. For example, if you read “Select File > Open,” you should click the File menu and then click the Open command.

- The firmware release is displayed as FRN X.xxx. The “FRN” signifies Firmware Release Number. The “X” is the major release number. The “xxx” is the minor update number.
Rockwell Automation Support

Rockwell Automation, Inc. offers support services worldwide, with over 75 sales/support offices, over 500 authorized distributors, and over 250 authorized systems integrators located through the United States alone. In addition, Rockwell Automation, Inc. representatives are in every major country in the world.

Local Support

Contact your local Rockwell Automation, Inc. representative for:

- Sales and order support.
- Technical training.
- Warranty support.
- Support service agreements.

Technical Assistance

If you need to contact Rockwell Automation, Inc. for technical assistance, please review the information in Chapter 5, Troubleshooting first. If you still have questions, then contact your local Rockwell Automation, Inc. representative.

**U.S. Allen-Bradley Drives Technical Support:**
E-mail: support@drives.ra.rockwell.com  
Tel:    (1) 262.512.8176  
Fax:    (1) 262.512.2222  
Online: www.ab.com/support/abdrives

**UK Customer Support Center:**
E-mail: esupport2@ra.rockwell.com  
Tel:    +44 (0) 870 2411802  
Fax:    +44 (0) 1908 838804

**German Customer Service Center:**
E-mail: ragermany-esc@ra.rockwell.com  
Tel:    +49 (0) 2104 960-630  
Fax:    +49 (0) 2104 960-501
Chapter 1

Getting Started

The 22-SCM-232 serial converter provides a communications interface between a computer or controller and any Allen-Bradley product implementing DSI, such as PowerFlex 4 and 40 drives. It uses the full-duplex, RS-232 DF1 protocol.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Components</td>
<td>1-1</td>
</tr>
<tr>
<td>Features</td>
<td>1-2</td>
</tr>
<tr>
<td>Compatible Products</td>
<td>1-2</td>
</tr>
<tr>
<td>Required Equipment</td>
<td>1-3</td>
</tr>
<tr>
<td>Safety Precautions</td>
<td>1-4</td>
</tr>
<tr>
<td>Quick Start</td>
<td>1-5</td>
</tr>
<tr>
<td>Modes of Operation</td>
<td>1-6</td>
</tr>
</tbody>
</table>

Components

Figure 1.1 Components of the Serial Converter

<table>
<thead>
<tr>
<th>#</th>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DSI Connection</td>
<td>Standard RJ45 connector. The 22-RJ45CBL-C20 cable is plugged into this connector.</td>
</tr>
<tr>
<td>2</td>
<td>Status Indicators</td>
<td>LEDs that indicate module operation, data is being received from and sent to the computer. Refer to Chapter 5, Troubleshooting, for more information.</td>
</tr>
<tr>
<td>3</td>
<td>RS-232 Serial Port</td>
<td>Locking low profile connector. The 1203-SFC serial cable is plugged into this connector.</td>
</tr>
<tr>
<td>4</td>
<td>22-RJ45CBL-C20 Cable</td>
<td>DSI cable (2 m) with male-to-male RJ45 connectors.</td>
</tr>
<tr>
<td>5</td>
<td>1203-SFC Serial Cable</td>
<td>Serial cable (2 m) with a locking low profile connector to connect to the serial converter and a 9-pin sub-miniature D female connector to connect to a computer.</td>
</tr>
<tr>
<td>Not Shown</td>
<td>DriveExplorer Lite CD-ROM</td>
<td>CD including DriveExplorer Lite software and documentation.</td>
</tr>
</tbody>
</table>
Getting Started

The 22-SCM-232 serial converter module features the following:

- The serial converter module can connect to products implementing DSI such as PowerFlex 4 and 40 drives.
- Provides a means for DriveExplorer (version 3.01 or higher) and DriveExecutive (version 1.01 or higher) software tools to access PowerFlex 4 and 40 drives.
- Allows various Allen-Bradley controllers, from MicroLogix to ControlLogix, to control and read/write data to PowerFlex 4 and 40 drives.
- Three status indicators (LEDs) report the operating status of the module.
- DF1 serial baud rates of 9600 bps, 19.2 kbps, and 38.4 kbps are supported. The factory default baud rate is 9600 bps.
- The serial converter module receives power from the DSI host product. An outside power source is not needed.
- DriveExplorer (version 3.01 or higher), DriveExecutive (version 1.01 or higher), or terminal emulation software can be used to configure the serial converter.
- The serial converter module is flash upgradeable to take advantage of feature enhancements. For example, version 1.xxx SCM’s can be flashed to version 2.xxx (or higher).

Compatible Products

The 22-SMC-232 serial converter module is compatible with Allen-Bradley products that support DSI. At the time of publication, compatible products include:

- PowerFlex 4 drives
- PowerFlex 40 drives
Required Equipment

Equipment Shipped with the Serial Converter Module

When you unpack the serial converter module, verify that the package includes:

- One 22-SCM-232 Serial Converter Module
- One 1203-SFC serial cable
- One 22-RJ45CBL-C20 cable
- One DriveExplorer Lite CD
- This manual

User-Supplied Equipment

To configure the serial converter, you must use one of the following:

- DriveExplorer software (version 3.01 or higher).
- DriveExecutive software (version 1.01 or higher).
- Terminal emulation software such as HyperTerminal.
- VT-100 compatible terminal.
Safety Precautions

Please read the following safety precautions carefully.

ATTENTION: Risk of injury or equipment damage exists. Only personnel familiar with drive and power products and the associated machinery should plan or implement the installation, start-up, configuration, and subsequent maintenance of the product using the serial converter module. Failure to comply may result in injury and/or equipment damage.

ATTENTION: Risk of injury or equipment damage exists. If the serial converter module is transmitting control I/O to the drive (indicated by a solid green diamond LED), the drive may fault when you remove or reset the serial converter module. Determine how your drive will respond before removing or resetting a connected serial converter module.

ATTENTION: Risk of injury or equipment damage exists. Parameter 04 - [Comm Flt Action] lets you determine the action of the serial converter module and connected drive if DF1 serial communications are disrupted. By default, this parameter faults the drive. You can set this parameter so that the drive continues to run. Precautions should be taken to ensure that the setting of this parameter does not create a hazard of injury or equipment damage.
Quick Start

This section is designed to help experienced users quickly start using the serial converter module. If you are unsure how to complete a step, refer to the referenced chapter.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review the safety precautions for the serial converter module.</td>
<td>Throughout This Manual</td>
</tr>
<tr>
<td>2</td>
<td>Install the serial converter module. Connect a 22-RJ45CBL-C20 cable to the serial converter module and the DSI drive. Then, connect a 1203-SFC serial cable to the serial converter module and a computer. Make sure that power has been applied to the DSI drive.</td>
<td>Chapter 2, Installing the Serial Converter Module</td>
</tr>
<tr>
<td>3</td>
<td>Configure the serial converter module for your application. Use one of the following to configure parameters in the serial converter module: • DriveExplorer (v3.01 or higher) • DriveTools 2000 (v1.01 or higher) • Terminal emulation software • VT-100 compatible terminal</td>
<td>Chapter 3, Configuring the Serial Converter Module</td>
</tr>
</tbody>
</table>

Figure 1.2  Example Serial Connection to a Personal Computer

Figure 1.3  Example Serial Connection to a Hand-Held Computer
Figure 1.4 Example Serial Connection to a Controller

![Example Serial Connection to a Controller](image)

Figure 1.5 Status Indicators on the Serial Converter Module

![Status Indicators on the Serial Converter Module](image)

The serial converter module uses three status indicators to report its operating status (Figure 1.5). The following table describes the state of the status indicators under normal operation:

<table>
<thead>
<tr>
<th>#</th>
<th>Status Indicator</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>➊</td>
<td>Diamond</td>
<td>Flashing Green</td>
<td>Serial converter is connected to a product implementing DSI.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Solid Green</td>
<td>Serial converter is or was receiving control I/O. Removing or resetting the serial converter may cause a serial fault in the product.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No power or Flash operation in progress.</td>
</tr>
<tr>
<td>➋</td>
<td>TX</td>
<td>Off</td>
<td>Not transmitting data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashing Green</td>
<td>Transmitting data.</td>
</tr>
<tr>
<td>➌</td>
<td>RX</td>
<td>Off</td>
<td>Not receiving data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashing Green</td>
<td>Receiving data.</td>
</tr>
</tbody>
</table>

If the diamond status indicator is red, there is a problem. Refer to Chapter 5, Troubleshooting.
Installing the Serial Converter Module

Chapter 2 provides instructions for installing and removing the serial converter module.

To provide proper termination of the serial cable shield, the chassis of the computer should be properly grounded. If it is not possible or practical to ground this, then a ground wire...
Installing the Serial Converter Module

**Important:** The DSI cable shield must be properly grounded in order to provide EMC protection. On the PowerFlex 4 and 40 drive that means that Pin 16 of the drive control terminal block must be connected to the drive earth ground terminal.

**Important:** The module **must not** be installed in an area where the ambient atmosphere contains volatile or corrosive gas, vapors or dust. If the module is not going to be installed for a period of time, it must be stored in an area where it will not be exposed to a corrosive atmosphere.

1. Connect the module to the drive using the 22-RJ45CBL-C20 cable.

**Figure 2.2 Connecting a 22-RJ45CBL-C20 Cable to the Serial Converter**

2. Connect the module to the computer using the 1203-SFC cable.

**Figure 2.3 Connecting a 1203-SFC Cable to the Serial Converter**

3. Verify that power is applied to the DSI-enabled drive. The serial converter module receives power from the drive, so it must be powered before the serial converter module will operate.

The diamond light on the serial converter module flashes green to indicate that the module is properly installed and receiving power. If it is not green, refer to Chapter 5, Troubleshooting.
Removing the Serial Converter Module

ATTENTION: Risk of injury or equipment damage exists. If the serial converter module is transmitting control I/O to the drive (indicated by a solid green diamond LED), the drive may fault when you remove or reset the serial converter. Determine how your drive will respond before removing or resetting a connected serial converter module.

1. Disconnect the 22-RJ45CBL-C20 cable from the DSI-enabled drive and then from the converter module. To disconnect the cable, press on the cable latch and then pull it out.

2. Disconnect the 1203-SFC serial cable from the serial converter module and then the computer.
Notes:
Chapter 3

Configuring the Serial Converter Module

Chapter 3 provides instructions and information for configuring the serial converter module.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tools</td>
<td>3-1</td>
</tr>
<tr>
<td>Using DriveExplorer</td>
<td>3-2</td>
</tr>
<tr>
<td>Using Terminal Emulation Software</td>
<td>3-3</td>
</tr>
<tr>
<td>Setting the RS-232 Serial Port Rate</td>
<td>3-7</td>
</tr>
<tr>
<td>Setting the Fault Action</td>
<td>3-8</td>
</tr>
<tr>
<td>Resetting the Serial Converter Module</td>
<td>3-9</td>
</tr>
</tbody>
</table>

For a list of parameters, refer to Appendix B, Serial Converter Module Parameters. For definitions of terms in this chapter, refer to the Glossary.

Configuration Tools

The serial converter module stores parameters and other information in its own non-volatile memory. You must, therefore, access the module to view and edit its parameters. The following tools can be used to access the module parameters.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>DriveExplorer software (version 3.01 or higher)</td>
<td>page 3-2 in this manual</td>
</tr>
<tr>
<td>DriveExecutive software (version 1.01 or higher)</td>
<td><a href="http://www.ab.com/drives/drivetools_2000">http://www.ab.com/drives/drivetools_2000</a></td>
</tr>
<tr>
<td>Terminal emulation software</td>
<td>page 3-3 in this manual</td>
</tr>
<tr>
<td>VT100-compatible terminal</td>
<td>Documentation for the terminal</td>
</tr>
</tbody>
</table>

Important: The RS-485 serial port on DSI products, such as PowerFlex 4 and 40 drives, does not need to be configured before using the serial converter module. DSI communications are configured automatically (19.2K baud and 8-N-1).
Using DriveExplorer

With DriveExplorer software, you can edit parameters in both the serial converter module and the connected DSI-enabled drive. On PowerFlex 4/40 drives (or other DSI products), you can also edit parameters in any of the attached peripherals. DriveExplorer Lite is shipped with the serial converter module and is a free, limited-feature version of DriveExplorer.

Important: Parameter 1 - [Adapter Cfg] must be set to “Auto” (default) for DriveExplorer to operate. HyperTerminal can be used if Parameter 1 - [Adapter Cfg] needs to be changed (see Using Terminal Emulation Software section).

DriveExplorer Lite Quick Start

This section is designed to help you quickly start using DriveExplorer Lite. If you are unsure how to complete a step, refer to the online help (select Help > Help Topics) or the DriveExplorer Getting Results Manual, Publication 9306-5.2, which is included on the CD.

1. Select Explore > Configure Communication. Select the communications port and baud rate that you are using. Select either checksum, and accept the default time for the time-out.

2. Select Explore > Connect > Local. A node will appear under Devices.

3. In the left pane, click the + signs to expand the tree. Click the product or serial converter module to display parameters in the right pane. Double-click a parameter to edit it.

Figure 3.1 DriveExplorer
Using Terminal Emulation Software

This section provides detailed instructions on how to use terminal emulation software to access the serial converter module so that you can view and edit its parameters or view its event queue.

A variety of terminal emulation programs can be used to establish a serial connection between a computer and the serial converter module. The following instructions describe how to establish the initial serial connection to the serial converter module using a computer running HyperTerminal – terminal emulation software provided with most Windows 95/98/NT 4.0/2000/XP operating systems.

**Important**: The following instructions use screen captures from Windows 95 HyperTerminal. If you are using a different operating system the screens may differ.

**To use HyperTerminal to access the serial converter module**

1. Verify that the serial converter module is installed correctly. Refer to Chapter 2, Installing the Serial Converter Module.

2. On the Windows 95 desktop, click the **Start** button, and then select **Programs > Accessories > HyperTerminal** to display the HyperTerminal dialog box (see Figure 3.2). Your dialog box may look slightly different.

![Figure 3.2 HyperTerminal Dialog Box in List View](image)

   On the Windows NT desktop, click the **Start** button, and then select **Programs > Accessories > HyperTerminal** to display the Connection dialog box (see Figure 3.3). Then, go to step 4.

3. Double-click **Hypertrm.exe**.

   The Connection Description dialog box appears in the HyperTerminal workspace.
Configuring the Serial Converter Module

4. In the Name window, type any name (for example, converter), and then select any icon in the Icon box.

5. Click OK to display the Phone Number dialog box (see Figure 3.4).

6. In the Connect Using window, select the communications port that you intend to use (usually Com1 or Com2).

7. Click OK to display the Properties dialog box.

8. Select the settings shown in Figure 3.5.

Important: If Parameter 03 - [DF1 Rate Cfg] was previously set to 19.2K or 38.4K, select that value in the Bits per second window.
9. Click OK. A blank HyperTerminal workspace appears.

10. Select File > Properties to display the Properties dialog box.

11. Click the Settings tab (see Figure 3.6).

12. Under Function, arrow, and ctrl keys act as, select Terminal keys.
13. In the Emulation window, select VT100.

14. Click OK to display the HyperTerminal workspace.

**TIP:** Select File > Save to save the HyperTerminal configuration that you just created. In future connections, you can select the saved configuration and quickly connect to the serial converter module.

15. Press the Enter key until the main menu appears (see Figure 3.7).

**Figure 3.7  Main Menu**

<table>
<thead>
<tr>
<th>Main Menu - Enter Number for Selection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1&gt; Display Setup Parameters</td>
<td>3-7</td>
</tr>
<tr>
<td>2&gt; Display Event Queue</td>
<td>5-3</td>
</tr>
<tr>
<td>3&gt; Flash Upgrade</td>
<td>5-5</td>
</tr>
</tbody>
</table>

If no text or meaningless text appears instead of the Main Menu, adjust the baud rate in your software. Refer to Chapter 5 in the Troubleshooting Potential Problems section for detailed instructions.

**To navigate in the terminal emulation software**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 . . 9</td>
<td>In the main menu, keys 1 – 3 select a menu option. In the parameter screen, keys 0 – 9 enter a value.</td>
</tr>
<tr>
<td>Esc</td>
<td>Display the main menu or abort changes to a parameter.</td>
</tr>
<tr>
<td>↑ OR ↓</td>
<td>Scroll through parameters or events.</td>
</tr>
<tr>
<td>← OR ←</td>
<td>Scroll through the values for a parameter.</td>
</tr>
<tr>
<td>Enter</td>
<td>Save a value for a parameter.</td>
</tr>
</tbody>
</table>
Setting the RS-232 Serial Port Rate

The serial port rate, sometimes called baud rate or DF1 rate, is the speed at which the computer and serial converter module communicate over RS-232. You can select a serial port rate of 9600, 19.2K, or 38.4K. The factory-default serial port rate is 9600.

**Important:** If you change the serial port rate in the serial converter module, you must set your software to use the same serial port rate. The serial converter module must be reset or power cycled before baud rate changes take affect.

**To set the serial port rate**

1. Set Parameter 03 - [DF1 Rate Cfg] to the desired rate.

   ![Figure 3.8   DF1 Rate Cfg Parameter in HyperTerminal](image.png)

   **Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press the ENTER key to save a new value.**

   3> DF1 Rate Cfg = 9600

2. Reset the serial converter module. Refer to [Resetting the Serial Converter Module](#) section in this chapter.

3. Set the serial port rate in your software to match the new serial port rate in the serial converter module.
Setting the Fault Action

By default, when DF1 serial communications are disrupted (for example, a serial cable is disconnected) and control I/O is being transmitted, the serial converter module and connected drive respond by faulting. You can set a different response to communication disruptions using Parameter 04 - [Comm Flt Action].

ATTENTION: Risk of injury or equipment damage exists.

Parameter 04 - [Comm Flt Action] lets you determine the action of the serial converter module and connected drive if communications are disrupted. By default, this parameter faults the drive. You can set this parameter so that the drive continues to run. Precautions should be taken to ensure that the setting of this parameter does not create a hazard of injury or equipment damage.

To change the fault action

- Set the value of Parameter 04 - [Comm Flt Action] to the desired response:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault</td>
<td>The drive is faulted and stopped. (Default)</td>
</tr>
<tr>
<td>Stop</td>
<td>The drive is stopped, but not faulted (DSI host products only).</td>
</tr>
<tr>
<td>Zero data</td>
<td>The drive is sent 0 for output data after a communications disruption. This does not command a stop.</td>
</tr>
<tr>
<td>Hold last</td>
<td>The drive continues in its present state after a communications disruption.</td>
</tr>
</tbody>
</table>

Figure 3.9 Comm Flt Action Parameter in HyperTerminal

Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press the ENTER key to save a new value.

4> Comm Flt Action = Fault

Changes to this parameter take effect immediately. A reset is not required.
Reseting the Serial Converter Module

Change to settings on some module parameters require that you reset the serial converter module before the new settings take effect. You can reset the module by cycling power to the module or by using Parameter 05 - [Reset Module].

**ATTENTION:** Risk of injury or equipment damage exists. If the serial converter module is transmitting control I/O to the drive (indicated by a solid green diamond LED), the drive may fault when you remove or reset the module. Determine how your drive will respond before removing or resetting a connected serial converter module.

To reset the serial converter

- Set Parameter 05 - [Reset Module] to either Reset Module or Set Defaults. “Reset Module” will reset the serial converter. “Set Defaults” will set all parameters in the serial converter to their factory-default values.

**Figure 3.10 Reset Module Parameter in HyperTerminal**

Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press theENTER key to save a new value.

5> Reset Module = Reset Module

After you enter the “Reset Module” value, the serial converter will be reset. This parameter will then be reset to “Ready.”
Notes:
Chapter 4

Controlling PowerFlex 4 and 40 Drives with Allen-Bradley Controllers

Chapter 4 illustrates how to use the 22-SCM-232 serial converter with Allen-Bradley controllers to control and read/write data to PowerFlex 4 and 40 drives.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller Compatibility</td>
<td>4-1</td>
</tr>
<tr>
<td>Cabling Requirements</td>
<td>4-2</td>
</tr>
<tr>
<td>Messaging (MSG Instruction)</td>
<td>4-3</td>
</tr>
<tr>
<td>PowerFlex 4 and 40 Memory Addressing</td>
<td>4-4</td>
</tr>
<tr>
<td>Example Controller Programs</td>
<td>4-4</td>
</tr>
</tbody>
</table>

Controller Compatibility

Any Allen-Bradley controller capable of initiating and receiving DF1 messages can be used with the 22-SCM-232 serial converter:

- MicroLogix 1000 (Series C or later discrete controllers, and all analog controllers)
- MicroLogix 1200/1500
- SLC 5/03, 5/04, 5/05
- PLC5
- ControlLogix/CompactLogix

The 22-SCM-232 converts the protocol from DF1 to Modbus RTU, and the media from RS232 to RS485. It can be used for point-to-point and multiple drive applications (see Figure 4.1 and Figure 4.2 respectively).

Important: DSI HIMs (22-HIM-*) and/or DSI communication adapters (22-COMM-*) cannot be used in an Allen-Bradley controller/22-SCM-232 system.
In addition to using the 22-SCM-232 serial converter module, the required cabling depends on the type of Allen-Bradley controller being used:

<table>
<thead>
<tr>
<th>Controller Type</th>
<th>Requires 22-SCM-232 plus . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroLogix 1000/1200/1500 LSP</td>
<td>1761-CBL-PM02 or 1761-CBL-AP00 (8-pin DIN to 9-pin Female) and 1203-SNM Serial Null Modem adapter (9-pin Male to 9-pin Male)</td>
</tr>
<tr>
<td>MicroLogix 1500 LRP</td>
<td>—</td>
</tr>
<tr>
<td>SLC 5/03, 5/04 or 5/05</td>
<td>—</td>
</tr>
<tr>
<td>PLC5</td>
<td>9-pin Male to 25-pin Male adapter (3rd party)</td>
</tr>
<tr>
<td>ControlLogix/CompactLogix</td>
<td>—</td>
</tr>
</tbody>
</table>
Messaging (MSG Instruction)

Communications are handled via Message (MSG) instructions, which vary between the different controllers.

Figure 4.3 MicroLogix 1200/1500 MSG Setup Screen Example

The following descriptions are for the user configurable items of the MSG instruction.

<table>
<thead>
<tr>
<th>MSG User Configurable Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Channel # to which the 22-SCM-232 is connected</td>
</tr>
<tr>
<td>Communication Command</td>
<td>Message type used</td>
</tr>
<tr>
<td>Data Table Address</td>
<td>Source of write data/destination of read data</td>
</tr>
<tr>
<td>Size in Elements</td>
<td>Number of words to read/write (32 max.)</td>
</tr>
<tr>
<td>Message Timeout</td>
<td>Number of seconds before the message times out</td>
</tr>
<tr>
<td>Data Table Address</td>
<td>Memory address in PowerFlex 4/40 to be accessed</td>
</tr>
<tr>
<td>Local Node Addr (dec)</td>
<td>PowerFlex 4/40 node address (decimal)</td>
</tr>
<tr>
<td>Local Node Addr (octal)</td>
<td>PowerFlex 4/40 node address (octal)</td>
</tr>
<tr>
<td>Local/Remote</td>
<td>Type of communication used</td>
</tr>
</tbody>
</table>

For additional information on MSG instruction setups, refer to the respective controller instruction set reference manuals:

<table>
<thead>
<tr>
<th>Publication Name</th>
<th>Publication Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroLogix 1000</td>
<td>1761-6.3</td>
</tr>
<tr>
<td>MicroLogix 1200/1500 Instruction Set Reference Manual</td>
<td>1762-RM001…</td>
</tr>
<tr>
<td>SLC</td>
<td>1747-RM001…</td>
</tr>
<tr>
<td>PLC5</td>
<td>1785-6.1</td>
</tr>
<tr>
<td>ControlLogix Manual</td>
<td>1756-RM003…</td>
</tr>
<tr>
<td>CompactLogix Manual</td>
<td>1769-UM007…</td>
</tr>
</tbody>
</table>
PowerFlex 4 and 40 Memory Addressing

PowerFlex 4 and 40 control and status information, and parameters are addressed using N: file addressing.

Logic Command/Reference

<table>
<thead>
<tr>
<th>Control Data</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logic Command</td>
<td>N182:192</td>
</tr>
<tr>
<td>Reference</td>
<td>N182:193</td>
</tr>
</tbody>
</table>

Logic Status/Feedback/Additional Monitor Data

<table>
<thead>
<tr>
<th>Monitor Data</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logic Status</td>
<td>N183:198</td>
</tr>
<tr>
<td>Drive Error Code</td>
<td>N183:199</td>
</tr>
<tr>
<td>Frequency Command</td>
<td>N183:200</td>
</tr>
<tr>
<td>Output Frequency (Feedback)</td>
<td>N183:201</td>
</tr>
<tr>
<td>Output Current</td>
<td>N183:202</td>
</tr>
<tr>
<td>DC Bus Voltage</td>
<td>N183:203</td>
</tr>
<tr>
<td>Output Voltage</td>
<td>N183:204</td>
</tr>
<tr>
<td>Step # of Multi-Step Speed Operation</td>
<td>N183:205</td>
</tr>
<tr>
<td>Step # of PLC Operation</td>
<td>N183:206</td>
</tr>
<tr>
<td>Time of PLC Operation</td>
<td>N183:207</td>
</tr>
<tr>
<td>Counter Value</td>
<td>N183:208</td>
</tr>
</tbody>
</table>

The Logic Command and Logic Status bit definitions are described in Appendix I.

Parameters

PowerFlex 4 and 40 parameters are addressed using Integer File N150:x, where “x” equals the actual parameter number in the drive. For example:

N150:39 = Parameter 39 - [Accel Time 1]

Example Controller Programs

Example ladder logic programs are provided for each type of controller platform. Refer to the appropriate appendix:

<table>
<thead>
<tr>
<th>Controller Type</th>
<th>Example Ladder Logic Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroLogix 1000</td>
<td>See Appendix D</td>
</tr>
<tr>
<td>MicroLogix 1200/1500</td>
<td>See Appendix E</td>
</tr>
<tr>
<td>SLC</td>
<td>See Appendix F</td>
</tr>
<tr>
<td>PLC</td>
<td>See Appendix G</td>
</tr>
<tr>
<td>ControlLogix/CompactLogix</td>
<td>See Appendix H</td>
</tr>
</tbody>
</table>
Chapter 5

Troubleshooting

Chapter 5 provides information for troubleshooting potential problems with the serial converter module.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the Status Indicators</td>
<td>5-1</td>
</tr>
<tr>
<td>Module Diagnostic Items</td>
<td>5-3</td>
</tr>
<tr>
<td>Viewing and Clearing the Event Queue</td>
<td>5-3</td>
</tr>
<tr>
<td>Viewing and Clearing DF1 Communication Statistics</td>
<td>5-5</td>
</tr>
<tr>
<td>Troubleshooting Potential Problems</td>
<td>5-6</td>
</tr>
</tbody>
</table>

Understanding the Status Indicators

The serial converter module has three status indicators to report its operating status. See Figure 5.1.

Figure 5.1 Status Indicators on the Serial Converter

<table>
<thead>
<tr>
<th>#</th>
<th>Status Indicator</th>
<th>Description</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Diamond</td>
<td>Serial converter status</td>
<td><a href="#">Diamond Status Indicator on page 5-2</a></td>
</tr>
<tr>
<td>2</td>
<td>TX</td>
<td>Serial converter is transmitting data</td>
<td><a href="#">TX Status Indicator on page 5-2</a></td>
</tr>
<tr>
<td>3</td>
<td>RX</td>
<td>Serial converter is receiving data</td>
<td><a href="#">RX Status Indicator on page 5-2</a></td>
</tr>
</tbody>
</table>
Diamond Status Indicator

**ATTENTION:** Risk of injury or equipment damage exists. If the serial converter module is transmitting control I/O to the drive (indicated by a solid green diamond LED), the drive may fault when you remove or reset the module. Determine how your drive will respond before removing or resetting a serial converter module.

<table>
<thead>
<tr>
<th>Status</th>
<th>Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| Off    | Serial converter module is not powered or in Flash programming mode. | • Securely connect cables.  
• Apply power to the drive.  
• Wait while Flash is in progress. |
| Flashing Green | Serial converter module is operating and not transmitting control I/O. | No action. Removing or resetting the serial converter module will not cause a serial fault in the drive. |
| Solid Green | Serial converter module is operating and is or was transmitting control I/O. | No action. Removing or resetting the serial converter will cause a serial fault in the drive. |
| Flashing Red | The drive has not acknowledged the serial converter module. | • Securely connect cables.  
• Verify Parameter 1 - [Adapter Cfg] is set to “Auto.” |
| Solid Red | Link failure. | • Securely connect cables.  
• Replace the cable.  
• Cycle power to the drive. |
| Orange | | Contact Rockwell Automation Technical Support. |

RX Status Indicator

<table>
<thead>
<tr>
<th>Status</th>
<th>Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| Off    | Serial converter module is not receiving data. | • Verify that data is being transmitted by the PC.  
• Securely connect cables.  
• Apply power to the drive.  
• Configure the computer software to use the same serial port rate as the converter module. |
| Flashing Green | Serial converter module is receiving data from the computer. | No action. |

TX Status Indicator

<table>
<thead>
<tr>
<th>Status</th>
<th>Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| Off    | Serial converter module is not transmitting data. | • Verify that data is being transmitted.  
• Securely connect cables.  
• Apply power to the drive. |
| Flashing Green | Serial converter module is transmitting data to the computer. | No action. |
Module Diagnostic Items

The following diagnostic items can be accessed using DriveExplorer (version 3.01 or higher).

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Field Flash Cnt</td>
<td>Number of times the module has been Field Flashed.</td>
</tr>
<tr>
<td>2</td>
<td>Adapter Events</td>
<td>The number of events in the event queue.</td>
</tr>
<tr>
<td>3</td>
<td>Reference</td>
<td>Current value of the Reference being transmitted to the drive by this module.</td>
</tr>
<tr>
<td>4</td>
<td>Logic Command</td>
<td>Current value of the Logic Command being transmitted to the drive by this module.</td>
</tr>
<tr>
<td>5</td>
<td>Logic Status</td>
<td>Current value of the Logic Status being received from the drive by this module.</td>
</tr>
<tr>
<td>6</td>
<td>Feedback</td>
<td>Current value of the Feedback being received from the drive by this module.</td>
</tr>
</tbody>
</table>

Viewing and Clearing the Event Queue

The serial converter module has an event queue that reports the history of its actions.

To view the event queue

1. Access the event queue using a configuration tool. Refer to the Configuration Tools section in Chapter 3.

2. Scroll through events in the event queue. The most recent event can be found at 2R > Event Queue 1. The “R” stands for Read Only.

Figure 5.2 Example Event Queue in HyperTerminal

Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press the ENTER key to save a new value.

2R> Event Queue 1 = Normal Startup
Events

Many events in the Event queue occur under normal operation. If you encounter unexpected communications problems, the events may help you or Allen-Bradley personnel troubleshoot the problem. The following events may appear in the event queue:

<table>
<thead>
<tr>
<th>Code</th>
<th>Event Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F0</td>
<td>No Event</td>
</tr>
<tr>
<td>F1</td>
<td>Adapter Reset</td>
</tr>
<tr>
<td>F2</td>
<td>Slave Detected</td>
</tr>
<tr>
<td>F3</td>
<td>Slave Removed</td>
</tr>
<tr>
<td>F4</td>
<td>Host Timeout</td>
</tr>
<tr>
<td>F5</td>
<td>Slave Timeout</td>
</tr>
<tr>
<td>F6</td>
<td>Master Timeout</td>
</tr>
<tr>
<td>F7</td>
<td>Serial Timeout</td>
</tr>
<tr>
<td>F8</td>
<td>Control Enabled</td>
</tr>
<tr>
<td>F9</td>
<td>Control Disabled</td>
</tr>
<tr>
<td>F10</td>
<td>EEPROM Sum Flt</td>
</tr>
</tbody>
</table>

To clear the event queue

1. Access the event queue using a configuration tool. Refer to the Configuration Tools section in Chapter 3.

2. Set the value of 1 > Clr Event Queue to Enable, and then press Enter to clear the event queue.

Figure 5.3 Reset Event Queue in HyperTerminal

Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press the ENTER key to save a new value.

1> Clr Event Queue = Enable
**Viewing and Clearing DF1 Communication Statistics**

If you encounter unexpected communications problems or are creating an application that uses DF1 data, you can view the communications statistics in the serial converter module. Parameters 06 through 17 store this data.

To view and clear DF1 data, you must access the main menu in the serial converter module firmware. Refer to the Configuration Tools section in Chapter 3.

**To view DF1 data**

1. Access the parameters in the serial converter using a configuration tool. Refer to the Configuration Tools section in Chapter 3.

2. Scroll through the DF1 parameters. Parameters 06 through 17 contain DF1 data. For a description of each parameter, refer to Appendix B, Serial Converter Module Parameters.

**Figure 5.4 Example Parameter Display in HyperTerminal**

Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press the ENTER key to save a new value.

```
7R> DF1 Packets Sent = 0
```

**To clear DF1 counters**

1. Access the parameters in the serial converter using a configuration tool. Refer to the Configuration Tools section in Chapter 3.

2. Set the value of Parameter 06 - [Clear DF1 Counts] to Clear Counts, and then press Enter to clear the DF1 data.

**Figure 5.5 Example Parameter Display in HyperTerminal**

Press the UP ARROW or DOWN ARROW key to scroll through the parameter list. Press the LEFT ARROW or RIGHT ARROW key to modify parameter values. Press the ENTER key to save a new value.

```
6> Clear DF1 Counts = Clear Counts
```
Troubleshooting Potential Problems

<table>
<thead>
<tr>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
</table>
| You are unable to establish a connection between your computer and the serial converter module. | • If the status indicators are off, connect the cables and apply power to the drive.  
• Configure your software and serial converter module to use the same COMM port and serial port rate (baud rate). |
| After changing the serial port rate, you are no longer able to communicate with the serial converter module and connected drive. | Reset the serial port rate in the software. Instructions are included here to reset the serial port rate in HyperTerminal and DriveExplorer. If you are using a different configuration tool, refer to its user manual.  
**HyperTerminal**  
1. Select **File > Properties**, and then click **Configure**.  
2. Select the new baud rate, and then click **OK**.  
3. Save and close HyperTerminal.  
4. Double-click on your HyperTerminal file (*.ht) to restart HyperTerminal.  
5. Press **Enter** until the main menu appears.  
**DriveExplorer**  
1. Select **Explore > Configure Communication**.  
2. Select the new baud rate. DriveExplorer should start updating values again. If it does not, restart DriveExplorer. |
| For example, in HyperTerminal, meaningless text appears on the screen when you press Enter. In DriveExplorer, parameter values are not updated. | You set a new serial port rate, but the serial converter module is still using the old serial port rate.  
Reset the serial converter module. Refer to Chapter 3, Configuring the Serial Converter Module. |
| No communications to the drive. | • Verify cable connections.  
• Make sure Parameter 1 - [Adapter Cfg] is set to “Auto.” |
Appendix A presents the specifications for the serial converter module.

## Communications

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 side</td>
<td>RS-232 Serial DF1, Full Duplex</td>
</tr>
<tr>
<td>Port Rate</td>
<td>9600, 19.2K, or 38.4K</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Flow Control Error</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>CRC or BCC (Auto-Detected)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DSI Host side</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Drive Serial Interface (DSI)</td>
</tr>
<tr>
<td>Data Rates</td>
<td>19.2K</td>
</tr>
</tbody>
</table>

## Electrical

<table>
<thead>
<tr>
<th>Consumption</th>
<th>170mA at + 5V DC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The serial converter draws the required power</td>
</tr>
<tr>
<td></td>
<td>from the connected product. An external power</td>
</tr>
<tr>
<td></td>
<td>source is not required.</td>
</tr>
</tbody>
</table>

## Mechanical

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>103.5 mm (4.08 inches)</td>
</tr>
<tr>
<td>Width</td>
<td>73.4 mm (2.89 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>23.6 mm (0.93 inches)</td>
</tr>
<tr>
<td>Weight</td>
<td>70.88 g (2.5 oz.)</td>
</tr>
</tbody>
</table>
Environmental

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Non-Operating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temperature</strong></td>
<td>0 to +50°C (32 to 122°F)</td>
<td>-40 to +85°C (-40 to 185°F)</td>
</tr>
<tr>
<td><strong>Relative Humidity</strong></td>
<td>5 to 95% non-condensing</td>
<td></td>
</tr>
<tr>
<td><strong>Atmosphere</strong></td>
<td>Important: Serial converter module must not be installed in an area where the ambient atmosphere contains volatile or corrosive gas, vapors or dust. If the module is not going to be installed for a period of time, it must be stored in an area where it will not be exposed to a corrosive atmosphere.</td>
<td></td>
</tr>
<tr>
<td><strong>Vibration</strong></td>
<td>2.5G @ 5Hz-2KHz</td>
<td>5G @ 5Hz-2KHz</td>
</tr>
<tr>
<td><strong>Shock</strong></td>
<td>30 G peak acceleration, 11 (±1) ms pulse width</td>
<td>50 G peak acceleration, 11 (±1) ms pulse width</td>
</tr>
</tbody>
</table>

Agency Certification

<table>
<thead>
<tr>
<th>Agency</th>
<th>Certification</th>
</tr>
</thead>
<tbody>
<tr>
<td>UL</td>
<td>UL508C</td>
</tr>
<tr>
<td>cUL</td>
<td>CAN/CSA C22.2 No. 14-M91</td>
</tr>
<tr>
<td>CE</td>
<td>EN50178 and EN61800-3</td>
</tr>
<tr>
<td>CTick</td>
<td>AS/NZS 2064, Group 1, Class A</td>
</tr>
</tbody>
</table>

**Important:** For this product to be CE and CTick compliant, the shield of the serial cable and DSI cable must be terminated as described on Page 2-2.
Serial Converter Module Parameters

Appendix B provides information about the serial converter module parameters.

### Parameter List

<table>
<thead>
<tr>
<th>No.</th>
<th>Name and Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>[Adapter Cfg]</td>
<td></td>
</tr>
</tbody>
</table>
|     | Sets the operation of the serial converter module on DSI. Leave at “Auto” (setting) when used with software tools. | Default: 0 = Auto  
Values: 0 = Auto  
1 = Master  
2 = Slave  
3 = RTU Master  
4 = RTU Passthru  
Type: Read/Write  
Reset Required: No |
|     | **Important:** Parameter 1 - [Adapter Cfg] must be set to “Auto” (default) for DriveExplorer to operate. HyperTerminal can be used if Parameter 1 - [Adapter Cfg] needs to be changed (See Using Terminal Emulation Software). |         |
| 02  | [DF1 Addr Cfg]       |         |
|     | Sets the DF1 node address for the serial converter module. This is a decimal value. | Default: 1  
Minimum: 0  
Maximum: 254  
Type: Read/Write  
Reset Required: Yes |
| 03  | [DF1 Rate Cfg]       |         |
|     | Sets the serial port rate for the RS-232 DF1 serial port on the serial converter module. | Default: 0 = 9600  
Values: 0 = 9600  
1 = 19.2K  
2 = 38.4K  
Type: Read/Write  
Reset Required: Yes |
|     | **Important:** If you change the serial port rate in the serial converter module, you must set your software to use the same serial port rate. The serial converter module must be reset or power cycled before baud rate changes take affect. |         |
| 04  | [Comm Flt Action]    |         |
|     | Sets the action that the serial converter module and drive take if the module detects that DF1 serial communications are disrupted. This setting is effective only if I/O that controls the drive is transmitted through the serial converter module. | Default: 0 = Fault  
Values: 0 = Fault  
1 = Stop  
2 = Zero Data  
3 = Hold Last  
Type: Read/Write  
Reset Required: No |

**ATTENTION:** Risk of injury or equipment damage exists. **Parameter 04 - [Comm Flt Action]** lets you determine the action of the serial converter module and connected drive if communications are disrupted. By default, this parameter faults the drive. You can set this parameter so that the drive continues to run. Precautions should be taken to ensure that the setting of this parameter does not create a hazard of injury or equipment damage.
<table>
<thead>
<tr>
<th>No.</th>
<th>Name and Description</th>
<th>Details</th>
</tr>
</thead>
</table>
| 05  | [Reset Module]      | **Default:** 0 = Ready  
**Values:**  
0 = Ready  
1 = Reset Module  
2 = Set Defaults  
**Type:** Read/Write |
|     | No action if set to “Ready.” Resets the serial converter module if set to “Reset Module.” Restores the module to its factory-default settings if set to “Set Defaults.” This parameter is a command. It will be reset to “0 = Ready” after the command has been performed. |

**ATTENTION:** Risk of injury or equipment damage exists. If the serial converter module is transmitting I/O that controls the drive (indicated by a solid green diamond LED), the drive may fault when you remove or reset the module. Determine how your drive will respond before removing or resetting a connected serial converter module.

| 06  | [Clear DF1 Counts]  | **Default:** 0 = Ready  
**Values:**  
0 = Ready  
1 = Clear Counts  
**Type:** Read/Write  
**Reset Required:** No |
|     | No action if set to “Ready.” Resets the DF1 statistical parameters (numbers 07 – 15) to 0 if set to “Clear Counts.” This parameter is a command. It will be reset to “0 = Ready” after the command has been performed. |

| 07  | [DF1 Packets Sent] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 4294967295  
**Type:** Read Only |
|     | Displays the number of DF1 packets sent by the serial converter module. The value of this parameter is normally approximately equal to the value of Parameter 08 - [DF1 Packets Rcvd]. |

| 08  | [DF1 Packets Rcvd] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 4294967295  
**Type:** Read Only |
|     | Displays the number of DF1 packets received by the serial converter module. The value of this parameter is normally approximately equal to the value of Parameter 07 - [DF1 Packets Sent]. |

| 09  | [Undelivered Msgs] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 65535  
**Type:** Read Only |
|     | Displays the number of DF1 messages that were sent but not acknowledged.  
(1) This value is normally a low value. If it is continually incrementing and you are having communications problems, use a lower baud rate or replace the 1203-SFC serial cable. |

| 10  | [ENqs Sent] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 65535  
**Type:** Read Only |
|     | Displays the number of ENQ characters sent by the serial converter module.  
(1) |

| 11  | [ENqs Received] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 65535  
**Type:** Read Only |
|     | Displays the number of ENQ characters received by the serial converter module.  
(1) |

| 12  | [NAKs Received] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 65535  
**Type:** Read Only |
|     | Displays the number of NAK characters received by the serial converter module.  
(1) |

| 13  | [NAK Bad Packet] | **Default:** 0  
**Minimum:** 0  
**Maximum:** 65535  
**Type:** Read Only |
|     | Displays the number of NAKs sent by the serial converter module because of corrupt packets (improper protocol messages) as determined by the module.  
(1) |
<table>
<thead>
<tr>
<th>No.</th>
<th>Name and Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>[NAK No Memory] (^{(1)})</td>
<td>Displays the number of NAKs sent by the serial converter module because it did not have sufficient memory to buffer the incoming messages. The module runs out of memory if a command has not completed and there is no place to save the new commands.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Minimum: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximum: 65535</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type: Read Only</td>
</tr>
<tr>
<td>15</td>
<td>[Duplicate Msgs] (^{(1)})</td>
<td>Displays the number of duplicate messages sent to the serial converter module. This value contains the total number of consecutive messages received by the module with the same TNS (Transaction Sequence) number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Minimum: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximum: 65535</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type: Read Only</td>
</tr>
<tr>
<td>16</td>
<td>[DF1 Addr Actual]</td>
<td>Displays the DF1 address actually used by the serial converter module.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Minimum: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximum: 254</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type: Read Only</td>
</tr>
<tr>
<td>17</td>
<td>[DF1 Rate Actual]</td>
<td>Displays the serial port rate actually used for the DF1 serial port on the serial converter module.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 0 = 9600</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Values: 0 = 9600, 1 = 19.2K, 2 = 38.4K</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type: Read Only</td>
</tr>
<tr>
<td>18</td>
<td>[Adapter Type]</td>
<td>Displays the present operating mode for the serial converter module.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: 0 = Master</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Values: 0 = Master, 1 = Slave, 2 = RTU Master, 3 = RTU Passthru</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type: Read Only</td>
</tr>
</tbody>
</table>

\(^{(1)}\) This value is normally a low value. If it is continually incrementing and you are having communications problems, use a lower baud rate or replace the 1203-SFC serial cable.
Notes:
Appendix C provides information on updating peripheral product firmware.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing for a Flash Update</td>
<td>C-1</td>
</tr>
<tr>
<td>Performing a Flash Update with HyperTerminal</td>
<td>C-2</td>
</tr>
<tr>
<td>Troubleshooting Potential HyperTerminal Flash Problems</td>
<td>C-3</td>
</tr>
</tbody>
</table>

### Preparing for a Flash Update

Please take the following precautions to ensure a successful Flash:

- Obtain the new firmware version from Rockwell Automation, Inc. Save it to the hard drive of the computer. Do not attempt to perform a Flash from a floppy disk or a network.

- Read all instructions supplied with the new firmware file.

- Use a computer running terminal emulation software that supports Xmodem transfers (e.g. HyperTerminal). In this manual, we show how to use HyperTerminal.

- Record parameter values in the device that will be flashed. Updates may reset parameters to their default settings.

- Ensure that the DSI-enabled drive (e.g. PowerFlex 4) is stopped.

- Close all programs except the terminal emulation program that you are using to Flash the serial converter module.

- If you are using a laptop computer, turn off the FIFO buffers in HyperTerminal. In HyperTerminal, select **File > Properties** to display the Properties dialog box. Click **Configure**, and then click **Advanced**. Ensure that a check mark does not appear next to Use FIFO buffers.
Performing a Flash Update with HyperTerminal

1. In the main menu (Figure 3.7), press 3 to Update Flash program.

   The screen in Figure C.1 will immediately appear.

   **Figure C.1 Flash Menu**

   To update the Flash memory, you need a terminal program capable of downloading a binary file using the XMODEM protocol and a Flash update file from Rockwell Automation. When you press 'Y' to signal that you are ready to proceed, the terminal program will start displaying the letter 'C'. This signals the XMODEM protocol that the download may proceed. You then have one minute to start the transfer. Press CTRL-X to cancel an update started by mistake. Are you ready to proceed? (Y/N)

   **ATTENTION:** Risk of injury or equipment damage exists. When you perform a Flash update, the drive will fault if it is receiving control I/O from the serial converter module. Verify that the drive has stopped safely or is receiving control I/O from an alternate source before beginning a Flash update.

   **ATTENTION:** Risk of equipment damage exists. If you interrupt a flash procedure that is updating boot code, the device may become inoperable. To prevent this damage, follow the instructions provided with the new firmware file and do not interrupt a flash procedure while boot code is being flashed.

2. If the Flash can be completed safely, type Y. The letter “C” repeatedly appears. It is the Xmodem prompt and continues to appear until you send a binary file.

   **Important:** Press Ctrl + X to cancel a Flash update procedure.

3. Select **Transfer > Send File** to display the send file dialog box.

4. Click **Browse** and navigate to the Flash file.

5. Double-click the file. Its name appears in the Filename box (see Figure C.2).
6. In the Protocol box, select Xmodem.

7. Click **Send**. A dialog box appears and reports the progress of the download. When it is complete, the message “Operation Complete” appears.

   **Important:** Keep the device powered for 15 seconds after the operation has completed.

8. Press the Enter key to return to the main menu.

---

**Troubleshooting Potential HyperTerminal Flash Problems**

<table>
<thead>
<tr>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Transfer Cancelled by Remote System” message appears and the Flash is not completed.</td>
<td>• Restart HyperTerminal and repeat the Flash procedure.</td>
</tr>
<tr>
<td></td>
<td>• If you are using Windows NT 4.0, install SP3 or later. Windows NT service packs are available from the Microsoft web site: <a href="http://www.microsoft.com">http://www.microsoft.com</a>.</td>
</tr>
<tr>
<td></td>
<td>• Download a HyperTerminal Private Edition update from the Hilgraeve web site: <a href="http://www.hilgraeve.com">http://www.hilgraeve.com</a>. (Please note that there is a license requirement with this software.) Then, perform the Flash procedure again.</td>
</tr>
<tr>
<td>The “Xmodem File Send” for dialog box appears, but the Flash file is not transferred.</td>
<td>• Verify that you have selected the Xmodem protocol in the Send file dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Verify that the new file is on your hard disk. Do not attempt to Flash from a floppy disk or a network.</td>
</tr>
<tr>
<td></td>
<td>• Verify that you are sending the file within 60 seconds of pressing “Y” to confirm that you want to perform the Flash.</td>
</tr>
<tr>
<td>After completing a Flash, you are unable to communicate with the serial converter module. For example, meaningless text appears on the HyperTerminal screen.</td>
<td>Set the serial port rate to 9600. If parameters are changed during a Flash update, all parameters are set to their default settings.</td>
</tr>
</tbody>
</table>
Performing a Flash Update with DriveExplorer

DriveExplorer version 4.xx and higher can perform flash updates on DSI products that use flash memory, such as the 22-SCM-232 Serial Converter Module and 22-COMM-D DeviceNet adapter. A 22-SCM-232 (version 2.01 or higher) is required to perform the update.

DriveExplorer utilizes the same files used by ControlFlash, which can be downloaded from www.ab.com/drives.

The following steps illustrate how to flash update a 22-SCM-232, and can be applied to flashing other DSI products.

1. Connect the 22-SCM-232 using DriveExplorer, and select “Explore | Device Properties …”. Click on the Details tab to display the information about the 22-SCM-232. Click on the Flash Update button.

2. Select the revision of firmware that you wish to update to, and click on the Next> button.
3. Confirm that this is what you want to do by clicking the FLASH button.

4. The following dialog boxes will display information about the progress of the flash.
5. When the flash is completed, the “FLASH” button changes to “Close” and the “Cancel” button is grayed out.

6. DriveExplorer will prompt you to reconnect since the device may have changed its database because of the flash. Click “Yes” to reconnect.
Appendix D provides information on a MicroLogix 1000 example ladder program. The following ladder example demonstrates:

- Writing Logic Command and Reference
- Reading Logic Status, Feedback, and additional monitor data
- Writing/reading Parameter 39 - [Accel Time 1]
Figure D.1  Example MicroLogix 1000 Ladder Logic Program

MicroLogix 1000 communications to a PowerFlex 4/40 using a 22-SCM-232

Connection:
The 22-SCM-232 connects to the front port on the MicroLogix 1000 by using a 1203-SNM Null Modem adapter and a 1761-CBL-AP00 programming cable. The RJ45 cable on the 22-SCM-232 connects to the RJ45 port on the PowerFlex 4/40. The SCM provides both media (RS232 to RS485) and protocol (DF1 to Modbus RTU) conversions.

Additional PF4/40 drives can be added. Use one AK-U0-RJ45-SC1 Splitter Cable for connecting to the first drive, and one AK-U0-RJ45-TB2P for every drive. The "Local Node Address" in the MSG instruction identifies the drive node to communicate with.

PF4 Parameters:                                        22-SCM-232 parameters:
36 [Start Source] = 5 (Comm Port)           1 [Adapter Cfg] = RTU Master
38 [Speed Reference] = 5 (Comm Port)    2 [DF1 Addr Cfg] = 1 (this MUST equal Parameter 104 of the PF
4/40 it is connected to)                      4/40)
103 [Comm Data Rate] = 4 (19.2K)         3 [DF1 Rate Cfg] = 19.2k bps
104 [Comm Node Addr] = 1                    107 [Comm Format] = 0 (RTU 8-N-1)

For the PowerFlex 4/40 drives, 19.2K and 8-N-1 are a requirement and can not be changed. The data rate of the controller and SCM MUST be equal to each other, but can be set faster or slower than the drives baud rate if desired. It is recommended that 19.2K be used for ALL serial connections (controller, SCM, and drives) to be consistent and to avoid any errors.

This rung clears the read data area (N7:10-19) on the first program scan (N7:0 = a constant 0) and starts the messaging process by clearing the EN bit of the first MSG instruction.

This rung sets the timeout value for the first MSG instruction.
Figure D.1  Example MicroLogix 1000 Ladder Logic Program (Continued)

This rung sets the timeout value for the second MSG instruction.

0002
Enable (EN) N7:60
Error (ER) N7:60
Done (DN) N7:60

MSG #2
Time Out
Timer
TON
Timer On Delay
Timer T4:1
Time Base 0.01
Preset 200<
Accum 0<

MSG #2
Time Out
Timer T4:1

 Done (DN)

This rung sets the timeout value for the third MSG instruction.

0003
Enable (EN) N7:70
Error (ER) N7:70
Done (DN) N7:70

MSG #3
Time Out
Timer
TON
Timer On Delay
Timer T4:2
Time Base 0.01
Preset 200<
Accum 0<

MSG #3
Time Out
Timer T4:2

 Done (DN)

This rung sets the timeout value for the fourth MSG instruction.

0004
Enable (EN) N7:80
Error (ER) N7:80
Done (DN) N7:80

MSG #4
Time Out
Timer
TON
Timer On Delay
Timer T4:3
Time Base 0.01
Preset 200<
Accum 0<

MSG #4
Time Out
Timer T4:3

 Done (DN)
Messages must be interlocked and queued to run one at a time. In this example, (4) MSG's are used:
MSG #1  Writes Logic Command and Reference continuously
MSG #2  Reads a block of data, including Logic Status and Feedback, continuously
MSG #3  Writes Parameter 39 [Accel Time 1] on demand (one time per request)
MSG #4  Reads Parameter 39 [Accel Time 1] on demand (one time per request)

Write the Logic Command (N182:192) and Reference (N192:193) to the drive.

After the previous MSG is complete, this MSG reads a block of data (starting at N183:198) containing:
N7:10 Logic Status                                          (N183:198)
N7:11 Drive Error Code                                  (N183:199)
N7:12 Frequency Command (= Reference)      (N183:200)
N7:13 Output Frequency (Feedback)               (N183:201)
N7:14 Output Current                                    (N183:202)
N7:15 DC Bus Voltage                                   (N183:203)
N7:16 Output Voltage                                    (N183:204)

If a write is requested elsewhere in the user program (B3:0/0) and the previous MSG is complete, this MSG will write a value to Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.

Note: A parameter write causes an EEPROM write cycle on the drive. Do not develop a ladder program that will perform frequent writes.

![Diagram of message flow and data exchange](image-url)
If a read is requested elsewhere in the user program (B3:0/1) and the previous MSG is complete, this MSG will read Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.

Summary:

- **B3:0**
  - **Read Request**
  - **Write Request**
  - **Done**
  - **Error**

- **Pr. 39**
  - **Read**
  - **Write**

**Target Device**: 500CPU

**Setup Screen**

- **Control Block**: N7:80
- **Control Block Length**: 7

**MSG**

- **Read/Write Message**
  - **Read**
  - **Write**

**EN**

**DN**

**ER**

This rung resets all MSG instructions when the last MSG instruction has completed. Since the Parameter 39 Write and Read MSG’s are on demand and not continuous, the "last" MSG in the sequence can vary.

The Write (B3:0/0) and Read (B3:0/1) requests are also reset. This prevents these MSG's from operating continuously while providing feedback to the user program that they have completed.
Figure D.1 Example MicroLogix 1000 Ladder Logic Program (Continued)

```
UN7:60
15
Enable (EN)
N7:70
15
Enable (EN)
N7:80
15
Pr. 39
Write Request
B3:0
0
Pr. 39
Read Request
B3:0
1
```

0010 END
The data table used by the example ladder program is explained below:

**Figure D.2  MicroLogix 1000 Ladder Example Data Table Values**

<table>
<thead>
<tr>
<th>N7: Address</th>
<th>Name</th>
<th>Example Value (decimal)</th>
<th>Example Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Constant “0”</td>
<td>0</td>
<td>Fixed to “0” and used to clear read data on the first scan of the ladder program</td>
</tr>
<tr>
<td>10</td>
<td>Logic Status</td>
<td>1567</td>
<td>See Logic Status bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>11</td>
<td>Drive Error Code</td>
<td>0</td>
<td>No errors</td>
</tr>
<tr>
<td>12</td>
<td>Commanded Frequency</td>
<td>222</td>
<td>22.2 Hz</td>
</tr>
<tr>
<td>13</td>
<td>Output Frequency (feedback)</td>
<td>1</td>
<td>0.1 Hz</td>
</tr>
<tr>
<td>14</td>
<td>Output Current</td>
<td>1</td>
<td>0.01 A</td>
</tr>
<tr>
<td>15</td>
<td>DC Bus Voltage</td>
<td>3235</td>
<td>323.5 V</td>
</tr>
<tr>
<td>16</td>
<td>Output Voltage</td>
<td>118</td>
<td>11.8 V</td>
</tr>
<tr>
<td>20</td>
<td>Logic Command</td>
<td>18</td>
<td>See Logic Command bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>21</td>
<td>Reference</td>
<td>222</td>
<td>22.2 Hz</td>
</tr>
<tr>
<td>30</td>
<td>Pr. 39 - [Accel Time 1] Write Value</td>
<td>100</td>
<td>10.0 Seconds</td>
</tr>
<tr>
<td>31</td>
<td>Pr. 39 - [Accel Time 1] Read Value</td>
<td>100</td>
<td>10.0 Seconds</td>
</tr>
</tbody>
</table>

The following screens (Figure D.3 to Figure D.6) provide details of the MSG instructions used in the ladder example:
Figure D.3  Rung 5 Logic Command/Reference Write Message

Figure D.4  Rung 6 Logic Status/Feedback/Other Monitor Data Read Message
Figure D.5  Rung 7 Parameter 39 - [Accel Time 1] Write Message

Figure D.6  Rung 8 Parameter 39 - [Accel Time 1] Read Message
Appendix E provides information on a MicroLogix 1200/1500 example ladder program. The following ladder example demonstrates:

- Writing Logic Command and Reference
- Reading Logic Status, Feedback, and additional monitor data
- Writing/reading Parameter 39 - [Accel Time 1]

The example ladder program is for a MicroLogix 1500, but can also be applied to the MicroLogix 1200.
MicroLogix 1500 (LRP) communications to a PowerFlex 4/40 using a 22-SCM-232 Connection:
The 22-SCM-232 connects directly to Channel 1 on the LRP (DB9 connector) and the RJ45 port on the PowerFlex 4/40. It provides both media (RS232 to RS485) and protocol (DF1 to Modbus RTU) conversions.

Additional PF4/40 drives can be added. Use one AK-U0-RJ45-SC1 Splitter Cable for connecting to the first drive, and one AK-U0-RJ45-TB2P for every drive. The "Local Node Address" in the MSG instruction indicates the drive node to communicate with.

PF4 Parameters:                                      22-SCM-232 Parameters:
36 [Start Source] = 5 (Comm Port)                  1 [Adapter Cfg] = RTU Master
38 [Speed Reference] = 5 (Comm Port)               2 [DF1 Addr Cfg] = 1 (this MUST equal Parameter 104 of the
                                                  PF4/40 it is connected to)
103 [Comm Data Rate] = 4 (19.2K)                   3 [DF1 Rate Cfg] = 19.2k bps
104 [Comm Node Addr] = 1                          107 - [Comm Format] = 0 (RTU 8-N-1)

19.2K and 8-N-1 are a requirement and can not be changed. The data rate of the controller and SCM MUST be equal to each other, but can be set faster or slower than the drives baud rate if desired. It is recommended that 19.2K be used for ALL serial connections (controller, SCM, and drives) to be consistent and to avoid any errors.

This rung clears the read data area (N7:10-19) on the first program scan (N7:0 = a contant 0).

---

**Figure E.1 Example MicroLogix 1200/1500 Ladder Logic Program**

---

<table>
<thead>
<tr>
<th>0000</th>
<th>S:1</th>
<th>Logic Status</th>
<th>COP</th>
<th>Copy File</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>15</td>
<td></td>
<td></td>
<td>Source #N7:0</td>
</tr>
</tbody>
</table>

| 0001 | I:0 | Logic Command | STOP | N7:20 |
|      | 0   |               |      | 0     |

| 0002 | I:0 | Logic Command | START | N7:20 |
|      | 1   |               |      | 1     |

| 0003 | I:0 | Logic Command | JOG | N7:20 |
|      | 2   |               |     | 2     |

| 0004 | I:0 | Logic Command | RESET | N7:20 |
|      | 3   |               |      | 3     |
For demonstration purposes, the value of analog POT0 on the LRP processor is used to generate the Reference. Since the pot has a range of 0-250 (equates to 0.0 to 25.0 Hz), the pot value is multiplied by 3 to provide a range of 0 to 750 (0.0 to 75.0 Hz). Note that P034 [Minimum Freq] and P035 [Maximum Freq] on the drive determine the actual output frequency range on the drive. The default is 0.0 to 60.0 Hz.

Write the Logic Command (N182:192) and Reference (N182:193) to the drive.

Reads a block of data (starting at N183:198) containing:

- N7:10 Logic Status (N183:198)
- N7:11 Drive Error Codes (N183:199)
- N7:12 Frequency Command (= Reference) (N183:200)
- N7:13 Output Frequency (Feedback) (N183:201)
- N7:14 Output Current (N183:202)
- N7:15 DC Bus Voltage (N183:203)
- N7:16 Output Voltage (N183:204)
Figure E.1  Example MicroLogix 1200/1500 Ladder Logic Program (Continued)

Starts the message cycle over again

Writes Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.

Note: A parameter write causes an EEPROM write cycle on the drive. Do not develop a ladder program that will perform frequent writes.

Reads Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.

END
The data table used by the example ladder program is explained below:

**Figure E.2  MicroLogix 1200/1500 Ladder Example Data Table Values**

<table>
<thead>
<tr>
<th>N7: Address</th>
<th>Name</th>
<th>Example Value (decimal)</th>
<th>Example Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Constant &quot;0&quot;</td>
<td>0</td>
<td>Fixed to &quot;0&quot; and used to clear read data on the first scan of the ladder program</td>
</tr>
<tr>
<td>10</td>
<td>Logic Status</td>
<td>1807</td>
<td>See Logic Status bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>11</td>
<td>Drive Error Code</td>
<td>0</td>
<td>No errors</td>
</tr>
<tr>
<td>12</td>
<td>Commanded Frequency</td>
<td>336</td>
<td>33.6 Hz</td>
</tr>
<tr>
<td>13</td>
<td>Output Frequency (feedback)</td>
<td>336</td>
<td>33.6 Hz</td>
</tr>
<tr>
<td>14</td>
<td>Output Current</td>
<td>1</td>
<td>0.01 A</td>
</tr>
<tr>
<td>15</td>
<td>DC Bus Voltage</td>
<td>3308</td>
<td>330.8 V</td>
</tr>
<tr>
<td>16</td>
<td>Output Voltage</td>
<td>1343</td>
<td>134.3 V</td>
</tr>
<tr>
<td>20</td>
<td>Logic Command</td>
<td>16</td>
<td>See Logic Command bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>21</td>
<td>Reference</td>
<td>336</td>
<td>33.6 Hz</td>
</tr>
<tr>
<td>30</td>
<td>Pr. 39 - [Accel Time 1] Write Value</td>
<td>100</td>
<td>10.0 Seconds</td>
</tr>
<tr>
<td>31</td>
<td>Pr. 39 - [Accel Time 1] Read Value</td>
<td>100</td>
<td>10.0 Seconds</td>
</tr>
</tbody>
</table>

The following screens (Figure E.3 to Figure E.6) provide details of the MSG instructions used in the ladder example:
Figure E.3  Rung 8 Logic Command/Reference Write Message

Figure E.4  Rung 10 Logic Status/Feedback/Other Monitor Data Read Message
Figure E.5  Rung 12 Parameter 39 - [Accel Time 1] Write Message

Figure E.6  Rung 13 Parameter 39 - [Accel Time 1] Read Message
Notes:
Appendix F provides information on an SLC example ladder program. The following ladder example demonstrates:

- Writing Logic Command and Reference
- Reading Logic Status, Feedback, and additional monitor data
- Writing/reading Parameter 39 - [Accel Time 1]
SLC 5/03 communications to a PowerFlex 4/40 using a 22-SCM-232

Connection:
The 22-SCM-232 connects directly to Channel 0 on the processor (DB9 connector) and the RJ45 port on the PowerFlex 4/40. It provides both media (RS232 to RS485) and protocol (DF1 to Modbus RTU) conversions.

Additional PF4/40 drives can be added. Use one AK-U0-RJ45-SC1 Splitter Cable for connecting to the first drive, and one AK-U0-RJ45-TB2P for every drive. The "Local Node Address" in the MSG instruction identifies the drive node to communicate with.

PF4 Parameters:                                        22-SCM-232 parameters:
36 [Start Source] = 5 (Comm Port)           1[Adapter Cfg] = RTU Master
38 [Speed Reference] = 5 (Comm Port)    2[DF1 Addr Cfg] = 1 (this MUST equal Parameter 104 of the PF
103 [Comm Data Rate] = 4 (19.2K)            4/40 it is connected to)
104 [Comm Node Addr] = 1                  3 [DF1 Rate Cfg] = 19.2k bps
107 [Comm Format] = 0 (RTU 8-N-1)          19.2K and 8-N-1 are a requirement and can not be changed. The data rate of the controller and SCM MUST be equal to each other, but can be set faster or slower than the drives baud rate if desired. It is recommended that 19.2K be used for ALL serial connections (controller, SCM, and drives) to be consistent and to avoid any errors.

This rung clears the read data area (N7:10-19) on the first program scan (N7:0 = a constant 0).

<table>
<thead>
<tr>
<th>First Pass</th>
<th>Logic Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>S:1</td>
<td>COP</td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Copy File</td>
</tr>
<tr>
<td></td>
<td>Source</td>
</tr>
<tr>
<td></td>
<td>#N7:0</td>
</tr>
<tr>
<td></td>
<td>Dest</td>
</tr>
<tr>
<td></td>
<td>#N7:10</td>
</tr>
<tr>
<td></td>
<td>Length</td>
</tr>
<tr>
<td></td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Logic Command</th>
<th>N7:20</th>
</tr>
</thead>
<tbody>
<tr>
<td>STOP</td>
<td>0</td>
</tr>
<tr>
<td>START</td>
<td>1</td>
</tr>
<tr>
<td>JOG</td>
<td>2</td>
</tr>
<tr>
<td>RESET</td>
<td>3</td>
</tr>
</tbody>
</table>
Figure F.1  Example SLC Ladder Logic Program (Continued)

Write the Logic Command (N182:192) and Reference (N182:193) to the drive.

Starts the message cycle over again.

Reads a block of data (starting at N183:198) containing:

- N7:10 Logic Status
- N7:11 Drive Error Code
- N7:12 Frequency Command (= Reference)
- N7:13 Output Frequency (Feedback)
- N7:14 Output Current
- N7:15 DC Bus Voltage
- N7:16 Output Voltage

MG
 Starts the message cycle over again.

Write Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.

Note: A parameter write causes an EEPROM write cycle on the drive. Do not develop a ladder program that will perform frequent writes.

Read Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.
The data table used by the example ladder program is explained below:

**Figure F.2  SLC Ladder Example Data Table Values**

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Example Value (decimal)</th>
<th>Example Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Constant &quot;0&quot;</td>
<td>0</td>
<td>Fixed to &quot;0&quot; and used to clear read data on the first scan of the ladder program</td>
</tr>
<tr>
<td>10</td>
<td>Logic Status</td>
<td>1807</td>
<td>See Logic Status bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>11</td>
<td>Drive Error Code</td>
<td>0</td>
<td>No errors</td>
</tr>
<tr>
<td>12</td>
<td>Commanded Frequency</td>
<td>300</td>
<td>30.0 Hz</td>
</tr>
<tr>
<td>13</td>
<td>Output Frequency (feedback)</td>
<td>300</td>
<td>30.0 Hz</td>
</tr>
<tr>
<td>14</td>
<td>Output Current</td>
<td>1</td>
<td>0.01 A</td>
</tr>
<tr>
<td>15</td>
<td>DC Bus Voltage</td>
<td>3331</td>
<td>333.1 V</td>
</tr>
<tr>
<td>16</td>
<td>Output Voltage</td>
<td>1205</td>
<td>120.5 V</td>
</tr>
<tr>
<td>20</td>
<td>Logic Command</td>
<td>18</td>
<td>See Logic Command bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>21</td>
<td>Reference</td>
<td>300</td>
<td>30.0 Hz</td>
</tr>
<tr>
<td>30</td>
<td>Pr. 39 - [Accel Time 1] Write Value</td>
<td>100</td>
<td>10.0 Seconds</td>
</tr>
<tr>
<td>31</td>
<td>Pr. 39 - [Accel Time 1] Read Value</td>
<td>100</td>
<td>10.0 Seconds</td>
</tr>
</tbody>
</table>

The following screens (Figure F.3 to Figure F.6) provide details of the MSG instructions used in the ladder example:
Figure F.3  Rung 7 Logic Command/Reference Write Message

Figure F.4  Rung 9 Logic Status/Feedback/Other Monitor Data Read Message
Figure F.5  Rung 11 Parameter 39 - [Accel Time 1] Write Message

Figure F.6  Rung 12 Parameter 39 - [Accel Time 1] Read Message
Appendix G provides information on a PLC-5 example ladder program. The following ladder example demonstrates:

- Writing Logic Command and Reference
- Reading Logic Status, Feedback, and additional monitor data
- Writing/reading Parameter 39 - [Accel Time 1]
PLC-5 communications to a PowerFlex 4/40 using a 22-SCM-232

The 22-SCM-232 connects to Channel 0 on the processor (DB25 connector) via a 3rd party 9-to-25 pin adapter (Male-to-Male), and the RJ45 port on the PowerFlex 4/40. It provides both media (RS232 to RS485) and protocol (DF1 to Modbus RTU) conversions.

Additional PF4/40 drives can be added. Use one AK-U0-RJ45-SC1 Splitter Cable for connecting to the first drive, and one AK-U0-RJ45-TB2P for every drive. The "Local Node Address" in the MSG instruction identifies the drive node to communicate with.

PF4 Parameters:                                         22-SCM-232 parameters:
36 [Start Source] = 5 (Comm Port)                      1 [Adapter Cfg] = RTU Master
38 [Speed Reference] = 5 (Comm Port)                   2 [DF1 Addr Cfg] = 1 (this MUST equal Parameter 104 of the PF
4/40 it is connected to)                                4/40)
103 [Comm Data Rate] = 4 (19.2K)                        3 [DF1 Rate Cfg] = 19.2k bps
104 [Comm Node Addr] = 1                                107 [Comm Format] = 0 (RTU 8-N-1)

For the PowerFlex 4/40 drives, 19.2K and 8-N-1 are a requirement and can not be changed. The data rate of the controller and SCM MUST be equal to each other, but can be set faster or slower than the drives baud rate if desired. It is recommended that 19.2K be used for ALL serial connections (controller, SCM, and drives) to be consistent and to avoid any errors.

This rung clears the read data area (N7:10-19) on the first program scan (N7:0 = a constant 0).
Write the Logic Command (N182:192) and Reference (N182:193) to the drive.

Starts the message cycle over again.

Reads a block of data (starting at N183:198) containing:

- N7:10 Logic Status (N183:198)
- N7:11 Drive Error Code (N183:199)
- N7:12 Frequency Command (= Reference) (N183:200)
- N7:13 Output Frequency (Feedback) (N183:201)
- N7:14 Output Current (N183:202)
- N7:15 DC Bus Voltage (N183:203)
- N7:16 Output Voltage (N183:204)

Starts the message cycle over again.
Write Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.

Note: A parameter write causes an EEPROM write cycle on the drive. Do not develop a ladder program that will perform frequent writes.

Read Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where 'x' equals the parameter number.
The data table used by the example ladder program is explained below:

**Figure G.2  PLC-5 Ladder Example Data Table Values**

<table>
<thead>
<tr>
<th>N7: Address</th>
<th>Name</th>
<th>Example Value (decimal)</th>
<th>Example Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Constant &quot;0&quot;</td>
<td>0</td>
<td>Fixed to &quot;0&quot; and used to clear read data on the first scan of the ladder program</td>
</tr>
<tr>
<td>10</td>
<td>Logic Status</td>
<td>1807</td>
<td>See Logic Status bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>11</td>
<td>Drive Error Code</td>
<td>0</td>
<td>No errors</td>
</tr>
<tr>
<td>12</td>
<td>Commanded Frequency</td>
<td>350</td>
<td>35.0 Hz</td>
</tr>
<tr>
<td>13</td>
<td>Output Frequency (feedback)</td>
<td>350</td>
<td>35.0 Hz</td>
</tr>
<tr>
<td>14</td>
<td>Output Current</td>
<td>1</td>
<td>0.01 A</td>
</tr>
<tr>
<td>15</td>
<td>DC Bus Voltage</td>
<td>3228</td>
<td>322.8 V</td>
</tr>
<tr>
<td>16</td>
<td>Output Voltage</td>
<td>1397</td>
<td>139.7 V</td>
</tr>
<tr>
<td>20</td>
<td>Logic Command</td>
<td>18</td>
<td>See Logic Command bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>21</td>
<td>Reference</td>
<td>350</td>
<td>35.0 Hz</td>
</tr>
<tr>
<td>30</td>
<td>Pr. 39 - [Accel Time 1] Write Value</td>
<td>44</td>
<td>4.4 Seconds</td>
</tr>
<tr>
<td>31</td>
<td>Pr. 39 - [Accel Time 1] Read Value</td>
<td>44</td>
<td>4.4 Seconds</td>
</tr>
</tbody>
</table>

The following screens (Figure G.3 to Figure G.6) provide details of the MSG instructions used in the ladder example:
Figure G.3  Rung 7 Logic Command/Reference Write Message

![Image of Rung 7 Logic Command/Reference Write Message]

Figure G.4  Rung 9 Logic Status/Feedback/Other Monitor Data Read Message

![Image of Rung 9 Logic Status/Feedback/Other Monitor Data Read Message]
Figure G.5  Rung 11 Parameter 39 - [Accel Time 1] Write Message

Figure G.6  Rung 12 Parameter 39 - [Accel Time 1] Read Message
Notes:
Appendix H provides information on a ControlLogix/CompactLogix example ladder program. The following ladder example demonstrates:

- Writing Logic Command and Reference
- Reading Logic Status, Feedback, and additional monitor data
- Writing/reading Parameter 39 - [Accel Time 1]

The example ladder program is for a ControlLogix, but can also be applied to the CompactLogix.
Figure H.1   Example ControlLogix Ladder Logic Program

ControlLogix communications to a PowerFlex 4/40 using a 22-SCM-232

The 22-SCM-232 connects directly to the serial port on the processor (DB9 connector) and the RJ45 port on the PowerFlex 4/40. It provides both media (RS232 to RS485) and protocol (DF1 to Modbus RTU) conversions.

Additional PowerFlex 4/40 drives can be added. Use one AK-U0-RJ45-SC1 Splitter Cable for connecting to the first drive, and one AK-U0-RJ45-TB2P for every drive. The Communication tab in the MSG instruction setup identifies the port to use and the drive node to communicate with.

PF4 Parameters:  
36 [Start Source] = 5 (Comm Port)  
38 [Speed Reference] = 5 (Comm Port)  
103 [Comm Data Rate] = 4 (19.2K)  
104 [Comm Node Addr] = 1  
107 [Comm Format] = 0 (RTU 8-N-1)

22-SCM-232 Parameters:  
1 [Adapter Cfg] = RTU Master  
2 [DF1 Addr Cfg] = 1 (this MUST equal Parameter 104 of the PF 4/40 it is connected to)  
3 [DF1 Rate Cfg] = 19.2k bps  

For the PowerFlex 4/40 drives, 19.2K and 8-N-1 are a requirement and can not be changed. The data rate for the controller and the SCM MUST be equal to each other, but can be set faster or slower than the drives baud rate if desired. It is recommended that 19.2K be used for ALL serial connections (controller, SCM, and drives) to be consistent and to avoid any errors.

This rung clears the read data area (N7:10-19) on the first program scan (Constant_0 = "0").

This section takes the data from specific tags used elsewhere in the ladder program, and writes them to the respective Logic Command bits for output to the drive.

DriveCommandStop  Logic_Command.0

DriveCommandStart  DriveCommandStop  Logic_Command.1

DriveCommandJog  DriveCommandStop  Logic_Command.2

DriveCommandClearFaults  Logic_Command.3

DriveCommandForward  Logic_Command.4

DriveCommandForward  Logic_Command.5
Move the Logic Command and Reference words to the Control_Output array for transmission to the SCM.

7

Move
Source Logic_Command
18
Dest Control_Output[0]
18

Move
Source Reference
543
Dest Control_Output[1]
543

Write the Logic Command (N182:192) and Reference (N182:193) to the drive.

8

Starts the message cycle over again.

9

Reads a block of data (Starting at N183:198) containing:

- N7:10 Logic Status
- N7:11 Drive Error Code
- N7:12 Frequency Command (= Reference)
- N7:13 Output Frequency (Feedback)
- N7:14 Output Current
- N7:15 DC Bus Voltage
- N7:16 Output Voltage

10

Starts the message cycle over again.

11

DriveReadData[0].0

DriveStatusReady

12
Figure H.1  Example ControlLogix Ladder Logic Program (Continued)

13. DriveReadData[0].1
14. DriveReadData[0].3
15. DriveReadData[0].7
16. DriveReadData[0].8
17. Move
   Source DriveReadData[3]
   Dest Feedback 543

Write Parameter 39 - [Accel Time 1]. Uses N150:x addressing, where ‘x’ equals the parameter number.
Note: A parameter write causes an EEPROM write cycle on the drive. Do not develop a ladder program that will perform frequent writes.

18. PerformParameterWrite
19. ParameterWRMessage.DN
20. ParameterRDMessage.DN

Unlatch the PerformParameterWrite request to indicate the message has completed. Operates one time per request.

21. Powerup_1shot
(End)
The data table used by the example ladder program is explained below:

**Figure H.2  ControlLogix Ladder Example Data Table Values**

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Description</th>
<th>Example Value (decimal)</th>
<th>Example Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant_0</td>
<td>Constant &quot;0&quot;</td>
<td>0</td>
<td>Fixed to &quot;0&quot; and used to clear read data on the first scan of the ladder program</td>
</tr>
<tr>
<td>DriveReadData[0]</td>
<td>Logic Status</td>
<td>1807</td>
<td>See Logic Status bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>DriveReadData[1]</td>
<td>Drive Error Code</td>
<td>0</td>
<td>No errors</td>
</tr>
<tr>
<td>DriveReadData[2]</td>
<td>Commanded Frequency</td>
<td>543</td>
<td>54.3 Hz</td>
</tr>
<tr>
<td>DriveReadData[3]</td>
<td>Output Frequency (feedback)</td>
<td>543</td>
<td>54.3 Hz</td>
</tr>
<tr>
<td>DriveReadData[4]</td>
<td>Output Current</td>
<td>1</td>
<td>0.01 A</td>
</tr>
<tr>
<td>DriveReadData[5]</td>
<td>DC Bus Voltage</td>
<td>3216</td>
<td>321.6 V</td>
</tr>
<tr>
<td>DriveReadData[6]</td>
<td>Output Voltage</td>
<td>2137</td>
<td>213.7 V</td>
</tr>
<tr>
<td>Logic_Command</td>
<td>Logic Command</td>
<td>18</td>
<td>See Logic Command bit descriptions (Appendix I)</td>
</tr>
<tr>
<td>Reference</td>
<td>Speed Reference</td>
<td>543</td>
<td>54.3 Hz</td>
</tr>
<tr>
<td>Parameter39_RDValue</td>
<td>Pr. 39 - [Accel Time 1] Read Value</td>
<td>50</td>
<td>50.0 Seconds</td>
</tr>
<tr>
<td>Parameter39_WRValue</td>
<td>Pr. 39 - [Accel Time 1] Write Value</td>
<td>50</td>
<td>50.0 Seconds</td>
</tr>
</tbody>
</table>
The following screens (Figure H.3 to Figure H.6) provide details of the MSG instructions used in the ladder example:

**Figure H.3** Rung 8 Control Output Message Screens (Logic Command/Reference)

**Figure H.4** Rung 10 Read Data Message Screens (Logic Status/Feedback/Other Monitor Data)
Figure H.5  Rung 18 Parameter Write Message Screens (Parameter 39)

Figure H.6  Rung 20 Parameter Read Message Screens (Parameter 39)
Notes:
Appendix I provides the definitions of the Logic Command/Logic Status words that are used for some products that can be connected to the 22-SCM-232 serial converter module. If you do not see the Logic Command/Logic Status for the product that you are using, refer to your product’s documentation.

### PowerFlex 4 and PowerFlex 40 Drives

**Logic Command Word**

<table>
<thead>
<tr>
<th>Logic Bits</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
<td>Stop</td>
<td>0 = Not Stop 1 = Stop</td>
</tr>
<tr>
<td></td>
<td>Start*</td>
<td>0 = Not Start 1 = Start</td>
</tr>
<tr>
<td></td>
<td>Jog</td>
<td>0 = Not Jog 1 = Jog</td>
</tr>
<tr>
<td></td>
<td>Clear Faults</td>
<td>0 = Not Clear Faults 1 = Clear Faults</td>
</tr>
<tr>
<td></td>
<td>Direction</td>
<td>00 = No Command 01 = Forward Command 10 = Reverse Command 11 = Change Direction (toggle)</td>
</tr>
<tr>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MOP Increment</td>
<td>0 = Not Increment 1 = Increment</td>
</tr>
<tr>
<td></td>
<td>Accel Rate</td>
<td>00 = No Command 01 = Accel Rate 1 Command 10 = Accel Rate 2 Command 11 = Hold Accel Rate</td>
</tr>
<tr>
<td></td>
<td>Decel Rate</td>
<td>00 = No Command 01 = Decel Rate 1 Command 10 = Decel Rate 2 Command 11 = Hold Decel Rate</td>
</tr>
<tr>
<td></td>
<td>Reference Select</td>
<td>000 = No Command 001 = Freq Source = Select 010 = Freq Source = Int. Freq 011 = Freq Source = Comm 100 = Preset Freq 1 101 = Preset Freq 2 110 = Preset Freq 3 111 = Preset Freq 4</td>
</tr>
<tr>
<td></td>
<td>MOP Decrement</td>
<td>0 = Not Decrement 1 = Decrement</td>
</tr>
</tbody>
</table>

* A 0 = Not Stop condition (logic 0) must first be present before a 1 = Start condition will start the drive.
## PowerFlex 4 and PowerFlex 40 Drives

### Logic Status Word

<table>
<thead>
<tr>
<th>Logic Bits</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0</td>
<td>x Ready</td>
<td>0 = Not Ready 1 = Ready</td>
</tr>
<tr>
<td></td>
<td>x Active</td>
<td>0 = Not Active 1 = Active</td>
</tr>
<tr>
<td></td>
<td>x Command Direction</td>
<td>0 = Reverse 1 = Forward</td>
</tr>
<tr>
<td></td>
<td>x Actual Direction</td>
<td>0 = Reverse 1 = Forward</td>
</tr>
<tr>
<td></td>
<td>x Accel</td>
<td>0 = Not Accelerating 1 = Accelerating</td>
</tr>
<tr>
<td></td>
<td>x Decel</td>
<td>0 = Not Decelerating 1 = Decelerating</td>
</tr>
<tr>
<td></td>
<td>x Alarm</td>
<td>0 = No Alarm 1 = Alarm</td>
</tr>
<tr>
<td></td>
<td>x Fault</td>
<td>0 = No Fault 1 = Fault</td>
</tr>
<tr>
<td></td>
<td>x At Speed</td>
<td>0 = Not At Reference 1 = At Reference</td>
</tr>
<tr>
<td></td>
<td>x Main Freq</td>
<td>0 = Not Controlled By Comm 1 = Controlled By Comm</td>
</tr>
<tr>
<td></td>
<td>x Operation Command</td>
<td>0 = Not Controlled By Comm 1 = Controlled By Comm</td>
</tr>
<tr>
<td></td>
<td>x Parameters</td>
<td>0 = Not Locked 1 = Locked</td>
</tr>
<tr>
<td></td>
<td>x Digital Input 1 Status</td>
<td>0 = Open 1 = Closed</td>
</tr>
<tr>
<td></td>
<td>x Digital Input 2 Status</td>
<td>0 = Open 1 = Closed</td>
</tr>
<tr>
<td></td>
<td>x Digital Input 3 * Status</td>
<td>0 = Open 1 = Closed</td>
</tr>
<tr>
<td></td>
<td>x Digital Input 4 * Status</td>
<td>0 = Open 1 = Closed</td>
</tr>
</tbody>
</table>

*PowerFlex 40 only*
A  **Application Code**  
Code that runs in the serial converter module after the boot code calls it. It performs the normal operations of the system.

B  **BCC**  
Block Check Character. An error detection scheme where the 2’s complement of the 8-bit sum (modulo-256 arithmetic sum) of all data bytes in a transmission block. It provides a means of checking the accuracy of each message transmission.

**Boot Code**  
Code that runs when the serial converter module first receives power. It checks basic operations and then calls the application code.

C  **CRC**  
Cyclic redundancy check. An error detection scheme where all of the characters in a message are treated as a string of bits representing a binary number. This number is divided by a predetermined binary number (a polynomial) and the remainder is appended to the message as a CRC character. A similar operation occurs at the receiving end to prove transmission integrity.

D  **DF1 Protocol**  
A peer-to-peer link layer protocol that combines features of ANSI X3.28-1976 specification subcategories D1 (data transparency) and F1 (two-way simultaneous transmission with embedded responses).

**DF1 Rate**  
A unit of signaling speed equal to the number of discrete conditions or signal events per second. It is also called “baud rate” or “serial port rate.”

**DSI**  
Drive Serial Interface - a modification of the ModBus RS-485 serial communications protocol used by various Allen-Bradley drives and power products.

**DSI Peripheral**  
A device that provides an interface between DSI and a network or user. Peripheral devices are also referred to as “adapters” and “modules.” The
serial converter module and PowerFlex 4-Class HIMs (22-HIM*) are examples of DSI peripherals.

**DSI Product**
A device that uses the DSI communications interface to communicate with one or more peripheral devices. For example, a motor drive such as a PowerFlex 4-Class drive is a DSI product. In this manual, a DSI product is also referred to as “product” or “host.”

**DriveExplorer Software**
DriveExplorer software is a tool for monitoring and configuring Allen-Bradley products and adapters. It can be run on computers running Microsoft Windows 95, Windows 98, Windows NT (version 4.0 or higher), Windows ME, Windows 2000, Windows XP, and Windows CE (version 2.0 or higher) operating systems. DriveExplorer (version 3.01 or higher) can be used to configure this serial converter module and PowerFlex 4-Class drives. A free version of DriveExplorer Lite is included with the serial converter module. Information about DriveExplorer software can be accessed at http://www.ab.com/drives/driveexplorer.

**DriveTools Software**
A software suite designed for Microsoft Windows 95, Windows 98, and Windows NT (4.0 or higher) operating systems. To fully utilize DSI products, use DriveTools 2000 version 1.01 or higher. This software suite provides a family of tools that you can use to program, monitor, control, troubleshoot, and maintain Allen-Bradley products. Information about DriveTools can be accessed at http://www.ab.com/drives.

**Fault Action**
A fault action determines how the serial converter module and connected drive act when a communications fault (for example, a cable is disconnected) occurs or when the scanner is switched out of run mode. The former uses a communications fault action, and the latter uses an idle fault action.

**Flash Update**
The process of updating firmware in the serial converter module.

**Hold Last**
When communications are disrupted (for example, a serial cable is disconnected), the converter module and PowerFlex drive can respond by holding last state. Hold last state results in the drive receiving the last data received via the DF1 connection before the disruption. If the drive
was running and using the Reference from the converter module, it will continue to run at the same Reference.

**N Non-Volatile Storage (NVS)**

NVS is the permanent memory of a device. Devices such as the serial converter module and drive store parameters and other information in NVS so that they are not lost when the device loses power. NVS is sometimes called “EEPROM.”

**P PCCC (Programmable Controller Communications Command)**

PCCC is the protocol used by some controllers to communicate with devices on a network. Some software products (for example, DriveExplorer and DriveTools 2000) also use PCCC to communicate.

**PowerFlex 4-Class Drives**

The Allen-Bradley PowerFlex 4-Class family of drives include the PowerFlex 4 and PowerFlex 40. These drives can be used for applications ranging from 0.2 kW (0.25 HP) to 7.5 kW (10 HP). All PowerFlex 4-Class drives implement DSI, allowing them to use the 22-SCM-232 serial converter module.

**S Serial Converter**

The serial converter provides an electronic communications interface between any Allen-Bradley DSI product and a computer with an RS-232 port. This converter uses a full-duplex RS-232 DF1 protocol. The serial converter may also be referred to as “22-SCM-232 converter,” “converter,” “DSI peripheral.”

**Status Indicators**

Status indicators are LEDs that are used to report the status of the serial converter module. There are three status indicators on the converter.

**X Xmodem**

Developed by Ward Christensen in 1978, Xmodem is a protocol used to transfer data. You can use the Xmodem protocol to flash the firmware in the serial converter module or a device connected to it.

**Z Zero Data**

When communications are disrupted (for example, a serial cable is disconnected), the serial converter module and drive can respond with
zero data. Zero data results in the drive receiving zero as values for command data. If the drive was running and using the Reference from the converter module, it will stay running but at zero Reference.
Index

Numerics
22-SCM-232 converter, see serial converter

A
accessing parameters, 3-1
Adapter Cfg parameter, B-1
Adapter Type parameter, B-3
adapter, see serial converter
agency certification, A-2
application code, G-1
attentions, 1-4

B
baud rate, see DF1 rate
BCC, A-1, G-1
boot code, G-1

cables
catalog numbers, 2-1
connecting, 2-2
disconnecting, 2-3
selecting, 2-1
checksum, A-1
Clear DF1 Counts parameter, B-2
clearing DF1 data, 5-5
clearing events, 5-4
Comm Flt Action parameter, B-1
communications specifications, A-1
compatible products, 1-2
components of serial converter, 1-1
configuration tools, 3-1

ControlLogix example ladder program, H-1
converter, see serial converter
CRC, A-1, G-1

D
data bits, A-1
DF1
definition, G-1
viewing data, 5-5
DF1 Addr Actual parameter, B-3
DF1 Addr Cfg parameter, B-1
DF1 Packets Rcvd parameter, B-2
DF1 Packets Sent parameter, B-2
DF1 rate
definition, G-1
setting, 3-7
specification, A-1
DF1 Rate Actual parameter, B-3
DF1 Rate Cfg parameter, B-1
diagnostic items, 5-3
Diamond status indicator, 5-2
dimensions of serial converter, A-1
DriveExplorer
definition, G-2
documentation, P-1
free lite version, G-2
using, 3-2
web site, G-2
drives, see DSI products
DriveTools
definition, G-2
documentation, P-1
web site, G-2
DSI
cables, 1-1, 2-1
definition, G-1
peripheral, G-1
products, 1-2, G-2
Duplicate Msgs parameter, B-3

E
EEPROM, see Non-Volatile Storage (NVS)
ENQs Received parameter, B-2
ENQs Sent parameter, B-2
equipment
required, 1-3
supplied, 1-3
error detection, A-1
event queue
clearing events, 5-4
list of events, 5-4
viewing events, 5-3
events
clearing, 5-4
viewing, 5-3

F
fault action
definition, G-2
setting, 3-8
fault queue, see event queue
faults, see events
firmware
parameters in, 3-1
release, P-1
updating, C-1
firmware release, 1-1
Flash update
definition, G-2
instructions, C-1
troubleshooting, C-3

flow control, A-1
FRN, P-1

H
hold last
definition, G-2
setting, 3-8
HyperTerminal
navigating in, 3-6
setting up, 3-3
updating firmware with, C-3

I
installing a serial converter, 2-2

K
keys for navigating in firmware, 3-6

L
ladder example programs
ControlLogix, H-1
MicroLogix 1000, D-1
MicroLogix 1200/1500, E-1
PLC-5, G-1
SLC, F-1
LEDs, see status indicators

M
main menu for serial converter, 3-6
manual conventions, P-1
mechanical specifications, A-1
MicroLogix 1000 example ladder program, D-1
MicroLogix 1200/1500 example ladder program, E-1
N
NAK Bad Packet parameter, B-2
NAK No Memory parameter, B-3
NAKs Received parameter, B-2
Non-Volatile Storage (NVS)
definition, G-3
parameters in, 3-1

P
parameters
accessing, 3-1
list of, B-1 to B-3
manual conventions, P-1
parity, A-1
PCCC definition, G-3
PLC-5 example ladder program, G-1
power consumption, A-1
power cycling converter, 3-9
PowerFlex 4-Class drives, G-3
products, see DSI products
protocol, A-1

Q
quick start, 1-5

R
regulatory compliance, A-2
related documentation, P-1
removing the serial converter, 2-3
Reset Module parameter, B-2
resetting the serial converter, 3-9
RX status indicator, 5-2

S
safety precautions, 1-4
serial cables, 2-1, 2-2
serial converter
accessing, 3-1
components, 1-1
connecting cables, 2-2
definition, G-3
dimensions, A-1
event queue, 5-3
features, 1-2
illustration, 1-1
installing, 2-2
main menu, 3-6
parameters, B-1 to B-3
power consumption, A-1
removing, 2-3
resetting, 3-9
using with ControlLogix controller, H-1
using with hand-held PC, 2-1
using with MicroLogix 1000 controller, D-1
using with MicroLogix 1200/1500 controller, E-1
using with PLC-5 controller, G-1
using with SLC controller, F-1
serial port rate, see DF1 rate
SLC example ladder program, F-1
specifications, A-1
status indicators
definition, G-3
operating status, 5-1
troubleshooting with, 5-2
stop bits, A-1

tool support, P-2
terminal emulation software, 3-1, 3-3
tools, see equipment
troubleshooting, 5-1
TX status indicator, 5-2
Undelivered Msgs parameter, B-2
update, see Flash update

viewing DF1 data, 5-5
VT100-compatible terminal, 3-1

web sites, P-1, G-2

Xmodem
  definition, G-3
  using to flash firmware, C-1

zero data
  definition, G-3
  setting, 3-8